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Outcomes

A more effective process of assessing the 
employability potential of a person with disability

“GIP” and Employment Technicians better prepared 
to conduct effective job placements

Increase the recruitment of people with disabilities
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IO2 Job Profiling Tool 
(JPT)

2. Developing an employability JPT that enhances the effectiveness of “GIP”
in the integration of people with disabilities

1 JPT in 5 languages + English and with online component.

Grid analysis for the employability profile

1 Test (skills & indicators)

1 JPT online

Intermediate tests with 6 organizations
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Partner sharing on JPT

01
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“GIP” or 
guidance
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and training
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Evaluation 

outputs and 
guidance
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Online

05
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Shared Tools Example...

CASPER is a system developed in
Romania based on physical tests and an
electronic platform with a series of
complex tests to evaluate people
between 12 and 67 years.

It includes 30 standardized tests for 
the Romanian population and are 

accredited by the "College of 
Psychologists of Romania”. 
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STAR It is a system developed in
France focused on establishing the
pairing between the evaluation of
candidates and the offers of the
employers.

This tool seeks to treat the information 
collected in the evaluation process and 

make it comparable to what is 
requested in the job offer.

Indicadores	em	análise

4 Verificar	se	o	trabalho	está	em	conformidade 1
4 Montar	as	peças	a	serem	soldadas	em	um	modelo 4
1 Iniciar	máquinas	de	soldar 1
4 Defina	a	intensidade	nas	máquinas	de	soldar 4
4 Mudar	peças 4
4 Mudar	os	rolos 4
2 Mudar	as	botilhas	de	gás 2
1 Soldar	com	uma	estação	de	arco 1
2 Ler 2
1 Escrever 4
2 Contar 2
3 Orientação	espacial 2
4 Locomoção 3
2 Posturas 4
1 Motricidade	geral 1
3 Motricidade	fina 1
1 Aptidões	sensoriais 2
4 Trabalho	em	horário	especial 4
1 Trabalho	num	ambiente	específico 2
3 Aptidões	intelectuais 1
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Shared Tools Example...



Shared Tools Example...

Conclusions and challenges of the sharing process...

Evaluation process developed

Diversity of instruments of 
analysis
Integration of orientation and 
training courses
Consolidated relationships with 
specific employers

Reduced interorganizational
compatibility

Difficulty in transposing 
collected information into job 
offers
Instruments that synthesize and 
match emerging supply-demand
Online based on traditional 
platforms



JPT Design: inspiration and sources ...

Recognition
The system must provide feedback,
providing information on cases of
(in)success and learnings.

CASPER
Extensive work will be required if the
platform is to facilitate the synthesis of
the skills assessed and, if possible, to
allow the controlled introduction of
these skills.It should also facilitate the
indication of the candidate's evaluation
process.

STAR
Successful and efficient pairing is a key
aspect of the tool scalability. The
information introduced by the different
agents will have to be comparable and
make possible the referrals, but also their
consolidation.

Collaboration
The platform will have to allow easier
access for employers and organizations
and “GIP” to be able to introduce
information and analyze it, but also for
collaborative work.
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JPT development process

Testing and pilots
JPT refinement through specialists, workshops
and training pilots of Employment Technicians

“GIP” Process sharing
Each organization shared,
following a predefined structure,
the support processes for people
with disabilities: from the first
service to being employed.

Tools identification
Analysis of "composed" tools, already available online, measuring
their potential and adaptability to the national contexts.
Discussion and selection of the "tool(s)" or components for the
JPT Design

Sharing resources
Each organization shared the tests,
instruments, forms, and models it applies.
The competences analyzed and their
indicators were also shared.

JPT Design
Elaboration of the blueprint for the
tool with theoretical framework,
components description,
functionalities and technical
specifications.

IO2 Stages



JPT online (platform)
• Filling job offers with employer-adapted

requirements
• Candidate management based on the JPT
• Automated initial pairing with integrated key

information sharing

Skills Framework
• Identify the profile of the

candidate and assess their
productivity and potential for
employability

• Definition of the tool features and
specifications

Job Profiling Tool (JPT)
• Facilitating a comparison between the

potential of the applicant and the
needs of employers

• Facilitate the design of the counseling
process, mentoring and "pairing" with
the employer.

Employability profile of 
people with disabilities

• Mapping labor integration processes
• Sharing exercises and measuring

instruments of employability potential
• Skills, experience, knowledge and

attitudes
• Designing a profile framework

JPT specifications



A JPT Design process…

The JPT will include forms that
facilitate the measurement and
evaluation of the potential of
employability, as well as the
definition of a profile. The idea is
that the Employment Technician
can synthesize the information
in a way that is compatible with
the request made by the
employer. In addition, it is also
intended to facilitate access to
useful information focused on
the post-labor integration
process (integration and
personal development plan).

2
3

5
4

Creation of profiles: The job and 
the candidate

Analysis of the pairings

Consolidated routing

Integration plan for the 
workplace

1
Potential pairings

Employer 
Needs

Candidate history 
and critical 
information

Identification of the best person for 
the job

Candidate registration



The JPT Design... concluding…

Synthesize reviews
JPAT practitioners consume loads of
time in dealing with information. JPAT
tool should enhance this investment by
delivering effective synthesis sparing
time for building relationships.

Comparability
One of the key challenges when introducing
new services or tools is to make them
comparable with baseline or previous ones.
JPAT tool must provide information on key
indicators to measure results and impact.

Pairing
JPAT tool has to support initial work
with the employer and the pairing
process with the candidate, which can
mean adjustments and adaptation in
workplace and other workers.

Increase effectiveness
One of JPAT services critical task is to make
the proper referral or referrals to a job offer.
JPAT tool must increase the referrals
effectiveness providing to the JPAT manager
the suitable candidates for a vacancy.

Focus on potential
It is of outmost importance that JPAT can
support not only hiring process but also
provide key insights on a career and personal
development plan to support workers achieve
their performance potential.

Good hiring
The recruitment and selection processes are
time consuming and costly for organizations. It
is intended that the JPT Design increases the
effectiveness of the job placement delivering
value to employers.
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Architecture of the tool

Introduction - type of tool:
The DESIGN Job Placement Service Platform (JPSP) is a web-based tool aiming to promote inclusive
employment among the disabled persons population in a given country. The JPSP is firstly intended
to support organizations with job placement services which are accompanying persons with
disabilities to support their insertion into to the “normal” labour market and into employment
opportunities.

The JPSP intends to facilitate the process of
matching/adequacy between the person’s
skills/abilities and the position
requirements on a particular job offer
inserted by a company, easing the effort of
the employment counsellors and the access
to a sustained employment. It is a
mediation tool that forms the basis for
dialogue with the company and fully in line
with supported employment dynamics.



Architecture of the tool... Programming... 

The JPT has been first tested by specialised structures 
(job placement professionals and organizations) in a 
social intervention basis, using different forms and 
workflows and in particular an Excel sheet (annex 1) in 
which the suitability between candidate competences-
skills and job offer requirements was performed. The 
JPSP being easy to use and visual, it allows a co-
construction work between the mentor (job 
placement counsellor), the employer and the 
candidate. 

The JPT has a functionality to provide the selection of 
“the best candidate to the job offer”. It must rely on a 
simplified navigation providing an array of 
functionalities existent in other employment platforms 
with the adaptation to disabled persons seeking 
employment. as opposed to the protected labour 
market or other social occupational solutions.



Architecture of the tool... Programing... 

Generic Requirements:
1. The expected tool is a website accessible via mobile phones.
2. It is important to prepare the tool to be easily used in different languages, being initially

developed in English. The expected tool will be translated into 5 languages (French, English,
Romanian, Portuguese and Hungarian) in later stage.

3. It should accommodate four user profiles: super administrator (SA), country manager (CM),
job placement service organization (JPSO) and employer, using login. In case of JPSO and
employer they should be able to self pre-registration to be approved by the CM.

a. Super administrator with the capacity to create or remove country managers accounts.
b. Country managers with the capacity to create, approve the registration or remove JPSO

and employers accounts. Also to manage the disclosure of job offers inserted by
employers to JPSO.

c. JPSO with the capacity to registrate and manage candidates information, also giving
then a login to access their own data and to manage the disclosure of candidates to job
offers inserted by employers.

d. Employer to registrate job offers.
4. All user must have the option to send messages and communicate between them with

exception of candidates which can only communicate with their JPSO. JPSO can share
candidates files between them - if they permission by the candidate.



Architecture of the tool... Programing... 

5. It is also expected for the tool to be easy and user-friendly, with a clear visual aspect.
6. It expected to have the confidentiality issues addressed with a thick box in which user ensure

to have permission to share information given by users or in case of JPSO by the candidates.
The SA and CM have access to statistic information on the usage of the platform in the
indicators foreseen in the present document. They can’t accede the users (JPSO and
employer) files and either candidates. The CM has access to job offers to control the
requirements conformity.

7. The JPSP should allow users to upload, label, download and remove listed files in pdf. format.
8. The JPSP will be accomodated in Aproximar server, the front page will be compliant with

Erasmus+ visual identity obligations, including the disclaimer statement.
9. The JPSP front page should have information about disabled people employability,

communication about DESIGN - Disabled Signalling project link and information and a login
with user, password and recovery tick boxes to accede the back office of the platform.

The platform must be accessible to persons with disabilities at a later stage. to be discussed...
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Administrator page and functions 



Administrator page and functions 

Figura 4.2: Workflow of System Administrator. Figure 1 - shows the appearance of the administrator page.

The SA is the DESIGN JPSP manager, being able to ensure the web-based tool maintenance and 
create, manage and remove the Country Managers (CM) accounts. This profile accesses all of 
the platform’s features and configurations.

The SA is responsible for the JPSP sustainability through time and ensure the backup of all 
information as well as its compliance with EU laws on GDPR and system restoration. To secure a 
proper sustainability strategy, considering that is a not for profit platform, the SA is also responsible 
for the results, impacts and outcomes accountability both in social inclusion (service based) as 
financially.



Administrator page and functions 

1. Jobs:
1. Register Job -> It allows 

to register a job, all the 
fields are mandatory.

2. Edit/view -> It allows to 
view jobs, edit and 
delete them. Be aware 
that when you edit a 
profession it is modified 
in all the created 
advertisements. 

This is the user with the capacity to manage the platform in terms of architecture, design, its 
improvement and interventions to deal with “bugs”, unconformities, its fidelity and also to access 
the general platform usage statistics.

The Administrator is responsible for managing the entire application. He has the following functions 
available in his menu:



Administrator page and functions 

1. Jobs:
1. Register Job. 2. Edit/view. 



Administrator page and functions 

2. Regions/Countries:
1. Register Country -> It 

allows to register a 
country, all the fields 
are mandatory. 

2. Register Region -> It 
allows to register 
regions in the 
countries, all the 
fields are mandatory.  

3. Edit Countries -> It 
allows to delete and 
to edit a country. 

4. Edit Regions -> It 
allows to delete and 
to edit regions.



3. Institutions:

1. Register -> It 
allows to register 
an institution, all 
the fields are 
mandatory. 

2. View/Edit -> It 
allows to consult 
all registered 
institutions and 
still edit, delete 
and restore the 
password. The 
password that 
was assigned 
when the 
institution was 
created is 
restored.

Figure 1 - shows the appearance of the administrator page.

Administrator page and functions 



4. Companies:
1. Register -> It allows 

to register a 
company, all the 
fields are mandatory.

2. View/Edit -> It allows 
to consult all 
registered companies 
and still edit, delete 
and restore the 
password. The 
password that was 
assigned when the 
company was created 
is restored.

Figure 1 - shows the appearance of the administrator page.

Administrator page and functions 

The home page still shows some data about the state of the application.

Attention this page is only accessible by requesting an admin creation through 
contacto@aproximar.pt.



Institution page and functions 



Institutions’ page and functions 

The institution is the page for the institutions in which they can register their users and consult the 
advertisements that are available in the region where they operate.

This profile is dedicated to organization providing support to disabled persons employability. The
JPSO has to do pre-registration and wait for the validation of the CM. The registration must be
done by the person assigned by the JPSO and the assignment letter should be uploaded in the JPSP.

Attention-> When the password reset is done, it is recommended to change it as soon as you log in
the first time.

The login is done is done from the number automatically created by the application, this number
can be seen on the Admin page-> institution-> view/edit

Figura 4.4: Workflow do actor Job Placement Service Manager.



Institutions’ page and functions 

1. Users:
1. Register-> It allows to 

register its users, all the 
fields are mandatory.

2. Manage Users-> It lists 
all users of the 
institution and it also 
allows to delete and edit 
each user personal data 
and consult all their 
personal information or 
file.



2. User Profile:

1. Register Profile-> It 
describes the 
technical 
information of the 
applicant, all the 
fields are 
mandatory.

2. Edit Profile-> It 
allows to edit the 
profile previously 
created in register 
profile. 

3. Assign job-> It 
allows to assign a 
job to a user.

Institutions’ page and functions 



3. Consult advertisements:

1. View-> It lists all 
registered 
advertisements in the 
institution's region of 
action. In each 
advertisement and 
when uploading view 
details it is possible to 
see the candidates that 
are compatible with the 
advertisement and 
submit an application 
and associate a 
message with a 
maximum of 250 
characters. This field is 
mandatory.

Institutions’ page and functions 



Company page and functions 



Companies’ page and functions 

The page dedicated to companies has the resources to create advertisements and see the 
interviews requests sent by the institutions.

This profile is dedicated to organization providing support to disabled persons employability. The 
JPSO has to do pre-registration and wait for the validation of the CM. The registration must be 
done by the person assigned by the JPSO and the assignment letter should be uploaded in the JPSP.

Attention-> When the password reset is done, it is recommended to change it as soon as you log in
the first time.

The login is done is done from the number automatically created by the application, this number
can be seen on the Admin page-> institution-> view/edit

Figura 4.4: Workflow for Employer.



Companies’ page and functions 

1. Applicants:
1. Interview requests-> It lists all job vacancies 

and at the footer of each advertisement there 
is an indication of how many candidates are 
already available. 

2. When loading see details, it is possible to see 
all the applicants’ information as well as the 
institution information to which the applicant 
belongs and also the message that the 
institution has sent attached to the 
application. 

3. When choosing to remove application is asked 
to write a message to the JPService. That 
message should indicate whether the 
applicant has been accepted or not or any 
other information. The message is limited to 
250 characters. When you click on remove 
application, the applicant is removed 
automatically.



2. Advertisements:

1. Register-> It is 
where you create an 
advertisement, all 
the fields are 
mandatory.   

2. View/edit-> It lists 
all the active 
advertisements and 
you also have the 
option to delete or 
edit the 
advertisement.

Institutions’ page and functions 
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